CONTOH CIPTAAN

APLIKASI

KTAA

Kartu Tanda Anggota Aisyiyah




DAFTAR ISI

O W 00 N o o un 1 b W W N N P -

e O T O = S =)
o O A D W W N R LB O O

COVER. ... ettt s e s s e s e s e e e eeeeaeeaeeeeeeaeaee s ettt e e e e e e s be s s bssssssa e e e e e e eeeeeeeeaeaeeeaeseneaees i
DAFTAR ISI..... ittt ettt et sttt e b e st s esane st e sbee st e e nbeesaneennees
PETUNJUK PENGGUNAAN..........ooiiiiiiiitieiitetee sttt ettt et ettt e siee st e st e st ebeesmeeeneennees

1. Loglin

2.  Dashboard

3. Bagaimana Cara Menambah Anggota

4. Bagaimana Cara Melakukan Pencarian Anggota yang Telah Terdaftar

5. Bagaimana Cara Melihat Daftar Anggota

6. Bagaimana Cara Mengubah Data Anggota

7. Bagaimana Cara Mengubah Foto pada Kartu Anggota

8. Bagaimana Cara Mencetak Kartu Anggota

9. Bagaimana Cara Melihat Daftar Pembayaran

10. Bagaimana Cara Menambahkan Konfirmasi Pembayaran

11. Bagaimana Cara Menghapus Data Konfirmasi Bayar

12. Bagaimana Cara Mencari Data Wilayah

13. Bagaimana Cara Menambah Wilayah

14. Bagaimana Cara Mengubah Data Wilayah

15. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Wilayah

16. Bagaimana Cara Menghapus Wilayah

17. Bagaimana Cara Mencari Data Daerah

18. Bagaimana Cara Menambah Daerah

19. Bagaimana Cara Mengubah Data Daerah

20. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Daerah

21. Bagaimana Cara Menghapus Daerah

22. Bagaimana Cara Mencari Data Cabang

23. Bagaimana Cara Menambah Cabang

24. Bagaimana Cara Mengubah Data Cabang

25. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Cabang

26. Bagaimana Cara Menghapus Cabang

27. Bagaimana Cara Mencari Data Ranting



28. Bagaimana Cara Menambah Ranting
29. Bagaimana Cara Mengubah Data Ranting
30. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Ranting
31. Bagaimana Cara Menghapus Ranting
32. Bagaimana Cara Mencari Pengguna
33. Bagaimana Cara Menambahkan Pengguna
34. Bagaimana Cara Mengubah Data Pengguna
35. Bagaimana Cara Mengubah Password
36. Bagaimana Cara Menonaktifkan/Mengaktifkan Pengguna
37. Bagaimana Cara Menghapus Pengguna
38. Bagaimana Cara Mengubah Nama Ketua Umum dan Sekretaris Umum pada Kartu Anggota
39. Bagaimana Cara Mengubah Tanda Tangan pada Kartu Anggota
40. Bagaimana Cara Mengubah Cap pada Kartu Anggota
41. Keluar
PROGRAI........coiiiii ittt ettt et e b ettt e bt s et e bt e s bt e e bt e e st e s bt e e b e e s bt e b e e sateeabeesateenteesbeesaneenbeesaneenrees

17
17
18
19
19
20
20
21
22
22
23
24
25
26



PETUNJUK PENGGUNAAN

1. Logln
Buka halaman melalui https://ktaa.sunhouse.co.id/
Masukkan username dan password kemudian Klik “Masuk”

@ PP Aisyiyah

Login
%’rp Emal
AISylyah Password

Gerakan Perempuan Muhammadiyah dengan Misi Dakwah Amar Ma'ruf Nahi
Mungkar dan Tajdid

Lupa Password

2. Dashboard
e Menampilkan data statistik Pimpinan Aisyiyah: Pimpinan wilayah, pimpinan daerah,
pimpinan cabang, pimpinan ranting, dan pimpinan cabang istimewa.
Menampilkan jumlah Anggota Aisyiyah
Menampilkan data jumlah Anggota Aisyiyah berdasarkan wilayah



X @ PP Aisyiyah

(12) WhatsApp
C @ kaasunhouseco.id,

it Apps WA ¥ Fgma @ Cava @ EJoumal 4 Gitlab (@ Instagram [] This huge black dia...
superadmin

= PP Aisyiyah

Statistik Pimpinan 'Aisyiyah

34 455 0 0

Wl
Pimpinan Wilayah Pimpinan Daerah Pimpinan Cabang Pimpinan Ranting

2 N
“rp

Superadmin

Jumlah Anggota 'Aisyiyah

88,483
Pengajuan Belum Validasi

B3 Dashboard
Anggota Terverifikasi

2 Anggota
Database
Anggota 'Aisyiyah Berdasarkan Wilayah

>  DataWilayah

35,081

>  DataDaerah
JAWA TENGAH

Aisyiyah App Version 1.0.0
—

3. Bagaimana Cara Menambah Anggota
Anggota > Tambah Anggota> Isi Form > Klik “Simpan”

X @ PP Aisyiyah

B (13) WhatsApp

<« C @ ktaasunhouse.co.id
GiApps B WA B Fgma @ Canva @ Eloumal &p Gitlab (@) Instagram [] This huge black dia...
superadmin

= PP Aisyiyah

\\\.J'fr.,// Pengelolaan Anggota

Pencarian Al

Tambah Anggota

|
I

=i &S
it N
VAR
Keanggotaan Muhammadiyah
Superadmin
NBN
B3 Dashboard
Data Pribadi
2 Anggota
Nama *
Database
> Data Wilayah Email
> Data Daerah
Nomor HP
Aisyiyah App Version 1.0.0

4. Bagaimana Cara Melakukan Pencarian Anggota yang Telah Terdaftar
Anggota > Pencarian Anggota > Masukkan nama atau nomor anggota pada kotak perncarian >

Tekan Enter



® (13) WhatsApp X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black dia..

= PP Aisyiyah superadmin
\\\.Jhr.,// Pengelolaan Anggota
A a4

—
//7//"'t|15"\\‘\\\

Superadmin

B3 Dashboard

& Anggota

Database

> Data Wilayah

> Data Daerah

Aisyiyah App Version 1.0.0

5. Bagaimana Cara Melihat Daftar Anggota

Anggota > Daftar Anggota

”n

Anda dapat mengatur menyortir data yang muncul pada halaman dengan cara klik icon “ =
kemudian pilih berdasarkan : Data Terakhir, Wilayah, Daerah, Cabang ataupun Ranting.

® (13) WhatsApp X @ PP Aisyiyah

< C @ Kkaasunhousacoid

fiApps @ WA P Fgma © Canva @ Eloumal &) Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin
\\\.Jhr.,// Pengelolaan Anggota
RS ‘g

ngg Pencarian Anggota

Tampilkan Data

Tambah Ar
AT @ -

Superadmin

§Z  Dashboard NBA Nama Wilayah Tanggal Pengajuan Status Keanggotaan
JAWA TENGAH
2 Anggota 0307.2101.88485 Sri Kirminah 2029-11-08 00:00:00 Valid Detail
JAWA TENGAH
Database 0307.2201.88485 Sri Murniyati 2029-11-08 00:00:00 Valid Detail
> Data Wilayah JAWA TENGAH
¥ 0307.4608.33505 Hj. Siti Komariyah 2029-11-08 00:00:00 Valid Detail
> Data Daerah JAWA TENGAH
0307.4608.33459 Hj. Siti Hardatik, BA 2029-11-08 00:00:00 Valid Detail
Aisyiyah App Version 1.0.0 JAWATENGAH
0307.5208.33464 Sri Sumarsih 2029-11-08 00:00:00 Valid Detail




6. Bagaimana Cara Mengubah Data Anggota
Anggota > Daftar Anggota > Detail > Lalu isikan data yang ingin diubah setelah itu klik “Perbarui
Data”

@ (13) WhatsApp X @ PP Aisyiyah

& C @ Ktaasunhouse.co.id/public

GiApps @ WA P Fgma @ Canva @ EJoumal & Gitlab (@ Instagram [] This huge black dia...

= PP Aisyiy - iperadmin
Keanggotaan Aisyiyah .
JAWA TENGAF -
KAB. KLATEN - P
B3 Dashboal
& Anggota Klaten Utara - Detail
Database Detail
Jonggrangan e |
>  Data Wila: E
Perbarui Data | =
>  Data Dael
Detail
Aisyiyah App Ver P
Detail

7. Bagaimana Cara Mengubah Foto pada Kartu Anggota
Anggota > Daftar Anggota > Detail > Klik Area Foto untuk mengubah foto pada Kartu Tanda
Anggota> Setelah itu Klik “Perbarui Data”

@ (13) WhatsApp X @ PP Aisyiyah

<& C & Kaasunhousecoid/public/anggots

GiApps @ WA P Fgma @ Canva @ EJoumal & Gitlab (@ Instagram [] This huge black dia...

= PP Aisyiy % Iperadmin

KARTU TANDA ANGGOTA ‘AISYIYAH
0307.2101.88485
<Sri Kirminah

::m:riv::;n Klik area foto untuk menambah atau mengganti foto
¥ab. Klaten

Sekrekaris Uimum

. H, Siti Noardjannah Djohantini, MM, M.S| 2. Hi. Dysh Sit Nuraini, M.P.
NBM/NEA. 548580/00013 N/ NEA. 549014700007

NBA: Detail
0307.2101.88485 E
Detail
Validasi anggota o |
Data anggota sudah divalidasi Detail
Tampilkan alamat lengkap a P
Detail
- Cetak kartu anggota m M =
Aisyiyah App Ver A
Detail




c ktaasunho

Apps (B WA Figma © Canva @ ElJournal Gitlab (@ Instagram [] This huge black dia...

Lampirkan Foto

Pilih File

Gunakan Foto

Bagaimana Cara Mencetak Kartu Anggota
Anggota > Daftar Anggota > Detail > Centang pada “Tampilkan alamat lengkap” jika ingin alamat
lengkap> Klik “Cetak Kartu”

@ PP Aisyiyah
ktaa sunhouse.co.id

Figma © Canva @ Elournal Gitlab (@ Instegram [] This huge black dia..

NBA:

0307.2101.88485

Validasi anggota

L]

Data anggota sudah divalidasi

Tampilkan alamat lengkap O

Cetak kartu anggota
Terakhir cetak pada 2022-01-24 02:32:58

Keanggotaan Muhammadiyah

NBM

88485

Data Pribadi

Nama *

Sri Kirminah




9. Bagaimana Cara Melihat Daftar Pembayaran
Klik pada menu “Pembayaran” di sisi kiri halaman.

@ PP Aisyiyah

< (¢]

@ ktaa.sunhouse.co.id/public/pembayara

@ WA @ Fgma © Cava @ Eloumal &) Gitlab (@ Instagram [] This huge black dia...

= PP Aisyiyah
Z ‘
“ris

Superadmin

B3 Dashboard

2 Anggota

B Pembayaran
Database

>  Data Wilayah

>  Data Daerah

> Data Cabang

Aisyiyah App Version 1.0.0

Pembayaran

No Invoice Nama Per

pay_623b217bd5826 arvian
pay_621954%¢eb49a4 Siti Fatimah

pay_6214baba5245d Ummi Rahmawati

otal Bayar

100,000

100,000

10,000

Tanggal Pembayaran

22 Mar 2022

1 Mar 2022

2 Mar 2022

superadmin

Tambah Konfirmasi Pembayaran

Statu:

Disetujui Detail
Disetujui Detail
Disetujui Detail

10. Bagaimana Cara Menambahkan Konfirmasi Pembayaran
Menu “Pembayaran” > Klik Fitur “Tambah Konfirmasi Pembayaran”> akan muncul form seperti
pada gambar berikut (isikan data pada form tersebut) > Klik “Simpan”

@ PP Aisyiyah

< (¢]

@ ktaasunhouse.co.id/public/pembayara

@ WA @ Fgma © Cava @ Eloumal &) Gitlab (@ Instagram [] This huge black dia...

Superadmin

B3 Dashboard
2 Anggota
B Pembayaran
Database
>  Data Wilayah
>  Data Daerah

>  DataCabang

Aisyiyah App Version 1.0.0

/77"'1|1*‘\§

Tambah Konfirmasi Pembayaran

Narma Rekening Pengiirr

LB 1B 3

Lampirkan Bukti

Batal

s

superadmin

Tambah Konfirmasi Pembayaran

Status #
Disetujui Detail
Disetujui Detail
Disetujui Detail
00f0 K < > >l




11. Bagaimana Cara Menghapus Data Konfirmasi Bayar
Menu “Pembayaran” > Klik “Detail” > Akan muncul tampilan seperti gambar berikut > Klik
“Hapus” > Akan muncul kotak dialog > Klik “OK” untuk melanjutkan menghapus data konfirmasi
pembayaran

@ PP Aisyiyah
< (c] ktaasunhouse.co.id

WA Figma € Canva EJournal Gitlab (@ Instagram This huge black dia...
=

Konfirmasi Bayar

Status Konfirmasi

Data Konfirmasi

Kode Konfirmasi
pay_623b217bd5826

Nama Pengirim
arvian

Tanggal Pembayaran
22 Mar 2022

Catatan Khusus
Tidak ada

Jumlah Pembayaran

(5]
& [&] ktaa:sunhouse.co.id

WA Figma @ Canva E Journal am| .
@ fio @ ktaa.sunhouse.co.id says

Anda yakin ingin menghapus data?

canee!

Kp. 1UU,UUU

Daftar Anggota yang Dibayarkan

1. Sumyati

2. Lina Rahmawati

3. Maryati

Lampiran Bukti Bayar

12. Bagaimana Cara Mencari Data Wilayah
Data Wilayah> Isikan nama wilayah/kode wilayah/No Sk



® (13) WhatsApp X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black dia..

= PP Aisyiyah

B3 Dashboard
Data Wilayah

& Anggota

Database

>  Data Wilayah
Kode Wilayah Nama Wilayah

> Data Daerah

Verifik

23 ACEH v
> Data Cabang
22 SUMATERA UTARA v
> DataRanting 21 SUMATERA BARAT v
Pengaturan 20 RIAU v
O Pengguna 19 JAMBI v
& KTA 18 SUMATERA SELATAN v
17 BENGKULU v
Aisyiyah App Version 1.0.0
s <o
=

3si Kebe

1013/SK-PPA/A/X/1990

212/SK-PPA/A/VIN/ 1988

715/SK-PPA/A/IN/1990

275/SK-PPA/A/VII/1988

277/SK-PPA/A/I/1989

107/3K-PPA/A/VII/1988

1378/SK-PPA/A/VIN/1994

13. Bagaimana Cara Menambah Wilayah

superadmin ¢}

Tambah Wilayah

Data Wilayah> Klik Tombol “Tambah Wilayah” > Isikan Data yang Diminta > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kiaasunhousecoid

npps (B wAa P Fgma @ Canva @ EJoumal &) Gitlab (@ Instagram [] This huge black di

= PP Aisyiyah

B3 Dashboard
Data Wilayah

2 Anggota

Database

> Data Wilayah

Kode Wilayah Nama W

>  DataDaerah

23 ACEH v
>  Data Cabang
22 SUMATERA UTARA v
’ Data Ranting 21 SUMATERA BARAT v
Pengaturan 20 RIAU V2
6 Pengguna 19 JAMBI v
& KTA 18 SUMATERA SELATAN v
17 BENGKULU v
Aisyiyah App Version 1.0.0
L\ -

si Keberadaan

No SK

1013/SK-PPA/AIX/1990

212/SK-PPA/A/VII/1988

715/SK-PPA/A/IINI1990

275/SK-PPA/A/VII1988

277/SK-PPA/A/I/1989

107/SK-PPA/A/VII/1988

1378/SK-PPA/A/NIN/1994

superadmin  §

Tambah Wilayah




ktaa.sunhous:

Figma @ Canva @ Eloumal Gitlab (@ Instagram This huge black dia...

Tambah Wilayah

[ Kode Wilayah *

Nama Wilayah *

Simpan

14. Bagaimana Cara Mengubah Data Wilayah
Data Wilayah> Klik Icon “ { ” > Klik “Edit” > Ubah data yang diinginkan > Klik “Simpan”

@ (13) What: < @ h X  +

ktaasunhous .id

Figma @ Canva @ Eloumnal Gitlab (@ Instagram This huge black dia...

Edit Wilayah

23

Nama Wilayah *
[ACEH\

NoSK

1013/SK-PPA/A/X/1990



15. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Wilayah

Data Wilayah> Klik Icon “ ” > Klik “Edit” > Klik “Batalkan Verifikasi” untuk membatalkan
Verifikasi / Klik “Verifikasi Keberadaan” untuk memberikan verifikasi.

@ (13) WhatsApp X @ PP Aisyiyah

& C @ Kaasunhouseco.id

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black di

= PP Aisyiyah superadmin  }

B3 Dashboard

Data Wilayah

A& Anggota

Database Cari Wilayat Tambah Wilayah

> Data Wilayah

Kode Wilayah Nama Wilayah erifikasi Keberadaan No $K
>  Data Daerah
23 ACEH v 1013/SK-PPA/A/X/1990 :
> Data Cabang
22 SUMATERA UTARA v NUSKPPAA, g Edit
>  DataRant
&t Ranting 7 SUMATERA BARAT N TIS/SKPPA/A) s Batalkan Verifikasi
Pengaturan 20 RIAU v 2ZIS/SKPPAMAL I Hapus
© Pengguna 19 JAMBI v 277/SK-PPA/A/I/1989 H
B K 18 SUMATERA SELATAN v 107/SK-PPA/A/VIIN988 H
17 BENGKULU v 1378/SK-PPA/A/VIII/ 1994 :
Aisyiyah App Version 1.0.0
L. . conicu oo oo -
= —— —

16. Bagaimana Cara Menghapus Wilayah

Data Wilayah> Klik Icon “ #” > Klik “Hapus”> Masukkan kode > Klik “Hapus”

® (13) WhatsApp X @ PP Aisyiyah

< C @ kaasunhousecoid

i Apps @ WA P Fgma © Canve @ Eloumal &) Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin  §

B3 Dashboard
Data Wilayah
2 Anggota

Database Aari Wi
Cari W

Tambah Wilayah

>  Data Wilayah

Kode Wilayah Nama Wilayah erifikasi Keberad No SK
> Data Daerah
23 ACEH g 1013/SK-PPA/A/X/1990 :
> Data Cabang
22 SUMATERA UTARA v 22SKPPAA 4y Edit
>  Data Rant
% Ranting 7 SUMATERA BARAT N TISISKPPA/AL s Batalkan Verifikasi
Pengaturan 20 RIAU v 275/SKPPAIMY Hapus
@ Pengguna 12 JAMBI v 277/SK-PPA/A/NTS :
B KA 18 SUMATERA SELATAN v 107/SK-PPA/A/VI/1988 H
17 BENGKULU v 1378/SK-PPA/A/VIII/ 1994 :
Aisyiyah App Version 1.0.0
==

10



17. Bagaimana Cara Mencari Data Daerah
Data Daerah> Isikan nama daerah/kode daerah/No Sk

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kisasunhousecoid/p

Apps (@ WA ¥ Fgma @ Canva @ Eloumal &) Gitlab (@) Instagram [] This huge black dia...

= PP Aisyiyah superadmin  §

Dashboard

Data Daerah

2 Anggota

Database Fari Daerah Tambah Daerah

>  Data Wilayah

Nama Daerah Wilaya No SK

>  Data Daerah

2306 KAB. ACEH SELATAN ACEH v 460/PPA/A/II/1989 H
> Data Cabang
2308 KAB. ACEH TENGGARA ACEH v 1618/PPA/A/V/1995 H
> Data Rantin
9 2310 KAB. ACEH TIMUR ACEH v 618/PPA/A/VI/1990 H
Pengaturan 2301 KAB. ACEH TENGAH ACEH v 1475/PPASA/IIN1995 H
@ Pengguna 2302 KAB. ACEH BARAT ACEH v 1253/PPA/A/XI1/1990 H
B KA 2305 KAB. ACEH BESAR ACEH v 656/PPA/A/XII/1982 H
2307 KAB. PIDIE ACEH v 1468/PPA/A/I/1995 H
Aisyiyah App Version 1.0.0
snnn oo ooz o BTN .

18. Bagaimana Cara Menambah Daerah
Data Daerah> Klik Tombol “Tambah Daerah” > Isikan Data yang Diminta > Klik “Simpan”

® (13) WhatsApp X @ PP Aisyiyah
e

i oeps @ WA

C @ kaasunhousecoid/public/data-d

® figma @ Cava @ EJoumal &) Gitlab (@ Instagram [ This huge black dia..

= PP Aisyiyah superadmin &
B3 Dashboard
= Dot | Tambah Daerah
. 4
= Anggota Tambah Daerah
Kode Daerah faan NoSK +
Database
E | Wilayah - | =
2306 469/PPA/A/11I/1989 H
>  Data Wilayah R | | B
2308 e Daera 1618/PPA/A/V/1995 H
>  DataDaerah — | =
2310 618/PPA/A/VI/1990 H
> DataCabang B | Narma K Kota * b
2301 e ebupsenRe 1475/PPA/A/IIN/1995 H
> DataRanting 2302 1253/PPA/A/XII/1980 :
Pengaturan 2305 656/PPA/A/XII/1989 H
© Fengguna 2307 Batal 1468/PPA/A/IIN/1995 H
2309 KABTACEHUTARA T TACEHTWTTTTT 1466/PPA/A/II1995 H
& KA /PPA/A/I/ :
2312 KAB. SIMEULUE ACEH v 1853/PPA/A/IX/2000 H
Aisyiyah App Version 1.0.0
2311 KAR_ACFH SINGKII ACEH oL RE:bf:Ti=1] VI ViV a1 O S—

11



19. Bagaimana Cara Mengubah Data Daerah

Data Daerah> Klik Icon “i” > Klik “Edit” > Ubah data yang diinginkan > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kaasunhousecoid/public

Gi Apps (B WA B Fgma @ Canva @ Eloumal &p Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin  §
B3 Dashboard

Cari Daerah .. Tambah Daerah

2 Anggota

Nama Daerah

Database

2306 KAB. ACEH SELATAN ACEH v 469/PPA/A/III/1989 H

>  Data Wilayah
2308 KAB. ACEH TENGGARA ACEH v WGWEJ’PP,

>  Data Daerah

2310 KAB. ACEH TIMUR ACEH v 618/PPA/A _,  Batalkan Verifikasi
> Data Cabang
2301 KAB. ACEH TENGAH ACEH v 1475/PPA/ B Hapus
B Hapus
>  DataRanting 2302 KAB. ACEH BARAT ACEH v 1253/PPA/A/XI1/1990 :
Pengaturan 2305 KAB. ACEH BESAR ACEH v 656/PPA/A/XII/1989 H
O rengguna 2307 KAB. PIDIE ACEH v 1468/PPA/A/III1995 H
2309 KAB. ACEH UTARA ACEH v 1466/PPA/A/III1995 H
B KA :
2312 KAB. SIMEULUE ACEH v 1853/PPA/A/IX/2000 H
Aisyiyah App Version 1.0.0
2311 KAR Al SINGKIL CEH 1 _’DD’\-”‘ [\/2000 H

@ (13) WhatsApp X @ PP Aisyiyah
& c

GiApps (B WA P Figma @ Canva @ Elournal & Gitlab (@ Instagram [] This huge black dia...

@ ktaa.sunhouse.co.id/public/c

= PP Aisyiyah superadmin  }
BS  Dashboard
== R | Tambah Daerah
. F | .
< Anggota Edit Daerah
Kode Daerah ah laan No SK #
Database o
| AceH | .
2306 469/PPA/A/II/1989 H
>  Data Wilayah R | | B
2308 1618/PPA/A/V/1995 :
>  DataDaerah — | =
2310 618/PPA/A/VI/1990 H
>  Data Caban: B | | B
g 2301 KAB. ACEH SELATAN 1475/PPA/A/III/1995 H
Dl 2302 L 1253/PPA/A/XII1990 g
BN 469/PPA/A/IN1989 E
Pengaturan 2305 656/PPA/A/XII/1989 :
@ Pengguna 2307 Batal m 1468/PPA/AIIN1995 H
2309 1466/PPA/A/III/1995 B
& KA /PPA/AII H
2312 KAB. SIMEULUE ACEH v 1853/PPA/A/IX/2000 :
Aisyiyah App Version 1.0.0
2311 KAR ACFH SINGKIL ACEH v REP L TV VIVIEI R S—
—_— — —

20. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Daerah

Data Daerah> Klik Icon “ ¢ ” > Klik “Edit” > Klik “Batalkan Verifikasi” untuk membatalkan Verifikasi
/ Klik “Verifikasi Keberadaan” untuk memberikan verifikasi.

12



® (13) WhatsApp X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black

= PP Aisyiyah superadmin

Dashboard
e

& Anggota

Kode Daerah Nama Daerah ilayah Verifikasi Keberadaan No SK 4
Database

2306 KAB. ACEH SELATAN ACEH v 469/PPA/A/III/1989 H
>  Data Wilayah
2308 KAB. ACEH TENGGARA ACEH v T18/PPAL ¢ Edit
>  Data Daerah
2310 KAB. ACEH TIMUR ACEH v 618/PPA/A |,
> Data Cabang
2301 KAB. ACEH TENGAH ACEH v T47S/PPA/  Hapus
> DataRanting 2302 KAB. ACEH BARAT ACEH v 1253/PPA/A/XII/1990 H
Pengaturan 2305 KAB. ACEH BESAR ACEH v 656/PPA/A/XII/1989 H
@ Pengguna 2307 KAB. PIDIE ACEH v 1468/PPA/A/IIN/1995 H
& KA 2309 KAB. ACEH UTARA ACEH v 1466/PPA/A/III/1995 :
2312 KAB. SIMEULUE ACEH v 1853/PPA/A/IX/2000 H
Aisyiyah App Version 1.0.0
2311 KAR Al SINGKI CEH 1R98/PPA/A/N/2000 H
— ——

21. Bagaimana Cara Menghapus Daerah

Data Daerah> Klik Icon “ ” > Klik “Hapus” > Masukkan kode > Klik “Hapus”

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kiaasunhousecoid

napps (B wAa B Fgma @ Canva @ EJoumal &) Gitlab (@) Instagram [] This huge black dia...

= PP Aisyiyah superadmin  §
=
Dashboard
" Cari Daerah Tambah Daerah
2 Anggota
Ko Nama Daerah Wilayal Verlfikasi Keberadaan #
Database
2306 KAB. ACEH SELATAN ACEH v 469/PPASA/1II/ 1989 H
> Data Wilayah
2308 KAB. ACEH TENGGARA ACEH v 1618/PPA/ 0 Eqn
>  Data Daerah
2310 KAB. ACEH TIMUR ACEH v 618/PPA/A _,  Batalkan Verifikasi
>  Data Cabang
2301 KAB. ACEH TENGAH ACEH v ISP Hapus
>  DataRanting 2302 KAB. ACEH BARAT ACEH v 1253/PPA/A/XII/1990 H
Pengaturan 2305 KAB. ACEH BESAR ACEH v 656/PPA/A/XII/1989 H
O Pengguna 2307 KAB. PIDIE ACEH v 1468/PPA/A/II1995 H
& KTA 2309 KAB. ACEH UTARA ACEH v 1466/PPA/A/IIN/1995 H
2312 KAB. SIMEULUE ACEH v 1853/PPA/A/IX/2000 H
Aisyiyah App Version 1.0.0
2311 KAR ACEH SINGKII CEH 1828/PPAJA/IV/2000 H
———— ==
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22. Bagaimana Cara Mencari Data Cabang
Data Cabang> Isikan nama daerah/kode daerah/No Sk

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kaasunhousecoid/public

Gi Apps (B WA B Fgma @ Canva @ Eloumal &p Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin  §
B3 Dashboard
Data Cabang
2 Anggota
Database 1ri Gabang Tambah Cabang
>  Data Wilayah
Kode Cabang Nama Cabang Daerat Wilayah No SK
> Data Daerah
010301 Temon KAB. KULON PROGO D.I YOGYAKARTA H
> Data Cabang
010302 Nates KAB. KULON PROGO D.I YOGYAKARTA H
> bata Ranting 010303 Panjatan KAB. KULON PROGO D.I YOGYAKARTA H
Pengaturan 010304 Galur KAB. KULON PROGO D.I YOGYAKARTA H
e Pengguna 010305 Lendah KAB. KULON PROGO D.I YOGYAKARTA H
& KTA 010306 Sentolo KAB. KULON PROGO D.I YOGYAKARTA H
010307 Pengasih KAB. KULON PROGO D.I YOGYAKARTA H
Aisyiyah App Version 1.0.0
ninnnn , in wiucuon, c oot .

23. Bagaimana Cara Menambah Cabang

Data Cabang> Klik Tombol “Tambah Cabang” > Isikan Data yang Diminta > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kiaasunhousecoid/p

napps (B wAa B Fgma @ Canva @ EJoumal &) Gitlab (@) Instagram [] This huge black dia...

= PP Aisyiyah superadmin  }
B3 Dashboard
Data Caban| Tambah Cabang
2 Anggota ' i
e ca Cahﬂ"ﬂ )
>  Data Wilayah -
Kode Cabang Verifikasi Keberadaan No SK #
>  DataDaerah | | &
010301 A H
> DataCabang B | | B
010302 A :
>  Data Ranting TET B :
Pengaturan 010304 - A i
O Pengguna 010305 A H
010306 1 Batal ; :
& KTA H
010307 Pengasl! KAB. KULON PROGO DI YOGYAKARTA :
Aisyiyah App Version 1.0.0
Popere . e e S o
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24. Bagaimana Cara Mengubah Data Cabang

Data Cabang> Klik Icon “ £ ” > Klik “Edit” > Ubah data yang diinginkan > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah
<« C @ ktaasunhouse.coid/pub
Gi Apps (B WA B Fgma @ Canva @ Eloumal &p Gitlab (@ Instagram [ This huge black dia...
= PP Aisyiyah superadmin
B3 Dashboard
Data Cabang
2 Anggota
Database i Cabar Tambah Cabang
>  Data Wilayah
Kode Cabang Daerat Wilayat No SK
> Data Daerah
010301 Temon KAB. KULON PROGO D.I YOGYAKARTA E]
> Data Cabang
010302 Wates KAB. KULON PROGO D.I YOGYAKARTA
> bata Ranting 010303 Panjatan KAB. KULON PROGO D.I YOGYAKARTA H
Pengaturan 010304 Galur KAB. KULON PROGO D.I YOGYAKARTA H
e Pengguna 010305 Lendah KAB. KULON PROGO D.I YOGYAKARTA
& KTA 010306 Sentolo KAB. KULON PROGO D.I YOGYAKARTA H
010307 Pengasih KAB. KULON PROGO D.I YOGYAKARTA H
Aisyiyah App Version 1.0.0
ninnnn , in wiucuon, c oot

@ (13) WhatsApp X @ PP Aisyiyah
& C @ Kkaasunhouseco.id/public/c
GiApps (B WA P Figma @ Canva @ Elournal & Gitlab (@ Instagram [] This huge black dia...
= PP Aisyiyah superadmin  }
BS  Dashboard
Data Caban( Edit Cabang
2 Anggota i
Database Cari Cabang . Tambah Cabang
> Data Wilayah [DWOGYAK#\RT/\ v l
Kode Cabang Verifikasi Keberadaan No SK #
>  DataDaerah = | D | =
010301 KAB. KULON PROGO - A B
> DataCabang B | | B
010302 A H
. B Temon F
>  Data Ranting TiET |
Pengaturan 010304 I .
© Pengguna 010305 A E
o oo = [ B
010307 PengaslH KAB. KULON PROGO D.I YOGYAKARTA
Aisyiyah App Version 1.0.0
cozeos L i coooo acocuaicacs
— — — ———

25. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Cabang

Data Cabang> Klik Icon “ i ” > Klik “Edit” > Klik “Batalkan Verifikasi” untuk membatalkan Verifikasi
/ Klik “Verifikasi Keberadaan” untuk memberikan verifikasi.
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@ PP Aisyiyah

X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Apps (@ WA P Figma
= PP Aisyiyah

B3 Dashboard

© Cava @ Eloumal & Gitlab (@ Instagram  [] This huge black dia...

Data Cabang

superadmin ¢}

& Anggota
Database Cari Cabang . Tambah Cabang
>  Data Wilayah
Kode Cabang Nama Cabang Daerah Wilayah No sK
>  Data Daerah
010301 Temon KAB. KULON PROGO D.I YOGYAKARTA :
> Data Cabang
010302 Wates KAB. KULON PROGO D.I YOGYAKARTA /it
>  Data Rantl
414 Ranting 010303 Panjatan KAB. KULON PROGO D.I YOGYAKARTA o Verifikasi Keberadaan
Pengaturan 010304 Galur KAB. KULON PROGO D.I YOGYAKARTA § Haous
@ Pengguna 010305 Lendah KAB. KULON PROGO D.I YOGYAKARTA H
& KA 010306 Sentolo KAB. KULON PROGO D.I YOGYAKARTA H
010307 Pengasih KAB. KULON PROGO D.I YOGYAKARTA :
Aisyiyah App Version 1.0.0
oo oo o .
= =

26. Bagaimana Cara Menghapus Cabang

Data Cabang> Klik Icon “ £ ” > Klik “Hapus” > Masukkan kode > Klik “Hapus”

@ PP Aisyiyah

X @ PP Aisyiyah

& C @ Kaasunhousecoid

Apps (@ WA P Figma
= PP Aisyiyah
B3 Dashboard
A& Anggota
Database
> Data Wilayah

> DataDaerah

© Cava @ Eloumal & Gitlab (@ Instagram [] This huge black dia...

Data Cabang

Cari Cabang .

Wilayah

superadmin  §

Tambah Cabang

No SK

010301 Temon KAB. KULON PROGO D.I YOGYAKARTA H
> Data Cabang
010302 Wates KAB. KULON PROGO D.I YOGYAKARTA /it
>  DataRant
ata Ramting 010303 Panjatan KAB. KULON PROGO DI YOGYAKARTA o Verifikasi Keberadaan
Pengaturan 010304 Galur KAB. KULON PROGO DI YOGYAKARTA § Heous
© Pengguna 010305 Lendah KAB. KULON PROGO D.1 YOGYAKARTA .
& KA 010306 Sentolo KAB. KULON PROGO D.I YOGYAKARTA :
010307 Pengasin KAB. KULON PROGO DI VOGYAKARTA :
Aisyiyah App Version 1.0.0
e . - .
== ==

27. Bagaimana Cara Mencari Data Ranting

Data Ranting> Isikan nama daerah/kode daerah/No Sk
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® (13) WhatsApp X @ PP Aisyiyah

& C @ Kkaasunhouseco.id/public/data-ranting

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black dia..

= PP Aisyiyah superadmin

B3 Dashboard
Data Ranting

& Anggota

Database Cari Ranting . Tambah Ranting

>  Data Wilayah

Kode Ranting Nama Ranting Caban;
>  Data Daerah
0103012002 Sindutan
> Data Cabang
0103012003 Palihan H
> IR 0108012004 Glagah :
Pengaturan 0103012005 Kalidengen
@ Pengguna 0103012006 Plumbon :
B “iA 0103012007 Kedundang H
0103012008 Demen
Aisyiyah App Version 1.0.0
ﬂﬂﬂﬂﬂﬂ anoo
==

28. Bagaimana Cara Menambah Ranting
Data Ranting> Klik Tombol “Tambah Ranting” > Isikan Data yang Diminta > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah

<« C @ Kaasunhouseca.id/public/data-ranting

i Apps @ WA F Figma @ Canva @ Eloumal & Gitlab (@) Instagram [] This huge black dia...

= PP Aisyiyah superadmin
BE  Dashboard Tambah Ranting

Data Rantin
A& Anggota L l

Database Cari Ranting ... Tambah Ranting

>  Data Wilayah

Kode Ranting eberadazn No §K #
>  DataDaerah | |
0103012002
> DataCabang B | | B
0103012003 - e
> BERRE 0103012004 H
Pengaturan 0103012005
@ Pengguna 0103012006 H
0108012007 q
- I Batal *

8 —
Aisyiyah App Version 1.0.0

s nnntnoon L .
—

29. Bagaimana Cara Mengubah Data Ranting
Data Ranting> Klik Icon “{” > Klik “Edit” > Ubah data yang diinginkan > Klik “Simpan”
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® (13) WhatsApp X @ PP Aisyiyah

< C @ Ktaasunhousa.co.id/public/data-ranting

Gidpps @ WA P Fgma @ Cava @ EJoumnal

& Gitlab (@ Instagram

[0 This huge black dia...

= PP Aisyiyah
B3 Dashboard
2  Anggota
Database
>  Data Wilayah
> Data Daerah
> Data Cabang
> Data Ranting
Pengaturan
e Pengguna

B KA

Aisyiyah App Version 1.0.0

Data Ranting

Cari Ranting ..

Kode Ranting

0103012002

0703012003

0103012004

0103012005

0703012006

0103012007

0103012008

s nn1anon
—

Nama Ranting

Sindutan

Palihan

Glagah

Kalidengen

Plumbon

Kedundang

Demen

Caban

Verifikasi Keberadaan

/it
v
B Hapus

superadmin ¢}

Tambah Ranting

@ (13) WhatsApp X @ PP Aisyiyah

< G & Kaasunhousecoid/public

Gii apps @ wa B Fgma @ Canva @ EJoumnal

& Gitlab (@ Instagram

[ This huge black dia...

= PP Aisyiyah
B3 Dashboard
2 Anggota
Database

>  Data Wilayah

>  Data Daerah

> DataCabang

> DataRanting

Pengaturan
O Pengguna
B KA

Aisyiyah App Version 1.0.0

Edit Ranting
Data Rantin
Cari Ranting Wilayah
— [Dwoemmnm -
Kode Ranting
N KAB.KULONPROGO -
0103012002
0103012003 .
Temen
0103012004
0103012005 Sindutan
0103012006
0103012007
0103012008

s nnnsaon
—

eberadaan

No SK

superadmin  §

30. Bagaimana Cara Memverifikasi dan Membatalkan Verifikasi Ranting

Data Ranting> Klik Icon “ ¢ ” > Klik “Edit” > Klik “Batalkan Verifikasi” untuk membatalkan Verifikasi
/ Klik “Verifikasi Keberadaan” untuk memberikan verifikasi.
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® (13) WhatsApp

X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Apps (@ WA P Figma

€ Canva @ Eloumal & Gitlab (@ Instagram

[0 This huge black dia...

= PP Aisyiyah
B3 Dashboard
& Anggota
Database
> Data Wilayah
> Data Daerah
>  Data Cabang
> Data Ranting
Pengaturan
@ Pengguna

B KA

Aisyiyah App Version 1.0.0

Data Ranting

Cari Ranting ..

Kode Ranting

0103012002
0703012003
0103012004
0103012005
0703012006
0103012007

0103012008

s nn1anon
—

Nama Ranting

Sindutan

Palihan

Glagah

Kalidengen

Plumbon

Kedundang

Demen

Caban

superadmin ¢}

No SK
g Edit

« Verifikasi Keberadaan

B Hapus

31. Bagaimana Cara Menghapus Ranting

Data Ranting> Klik Icon “{” > Klik “Hapus”> Masukkan kode > Klik “Hapus”

@ (13) WhatsApp

& C @ Kkaasunho

Apps (@ WA P Figma

X @ PP Aisyiyah

use.co.id,

© Canva @ Eloumal & Gitlab (@ Instagram

[0 This huge black dia...

= PP Aisyiyah
B3 Dashboard
A& Anggota
Database
> Data Wilayah
> DataDaerah
> Data Cabang
>  Data Ranting
Pengaturan
O Pengguna

B «a

Aisyiyah App Version 1.0.0

Data Ranting

Cari Ranting ..

Kode Ranting

0703012002

0103012003

0103012004

0103012005

0703012006

0103012007

0103012008

5 nnn1anan
—

Sindutan

Palihan

Glagah

Kalidengen

Plumbon

Kedundang

Demen

superadmin  §

g Edit
./ Verifikasi Keberadaan
B Hapus

32. Bagaimana Cara Mencari Pengguna
Pengguna > isikan email/nama/role pada kotak pencarian
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® (13) WhatsApp X @ PP Aisyiyah

< C @ Kaasunhouseco.id/pub

Apps @ WA P Fgma @ Canva @ Eloumal & Gitlab (@ Instagram [] This huge black dia..
= PP Aisyiyah superadmin  }

Dashboard

Pengelolaan Pengguna

& Anggota

Database Cari Pengguna ... Tambah Pengguna

>  Data Wilayah
Email Nam ole ql Registrasi Status

> Data Daerah

superadmin@aisyiyah.or.id superadmin eradmin 14 Dec 2021 Aktif E
> Data Cabang
eksternal @aisyiyah.or.id eksternal eksternal 21 Jan 2022 Aktif H
ata Rz dmin_daerah
>  DataRanting acehtimur@aisyiyah.orid Admin Daerah ?KZ;‘}\;E:T%MUR) 20 Jan 2022 Aktif H
dmin_wilayah
Pengaturan aceh_wilayah@aisyiyah or id Admin Wilayah Aceh :‘/:gltlh)mw 20 Jan 2022 Aktif :
P : fareedsurya@gmail.com Farid Test admin.vilayah 24 Jan 2022 Aktif :
© Pengguna yaee < ( D.I YOGYAKARTA } - N :
dmin_wilayah
a «n diy@aisyiyah.or.id Admin DIV ?D"\':‘écizifzx'w\) 07 Feb 2022 Aktif H
10 -

Aisyiyah App Version 1.0.0

33. Bagaimana Cara Menambahkan Pengguna
Pengguna> Klik Tombol “Tambah Pengguna” > Isikan Data yang Diminta > Klik “Simpan”

@ (13) WhatsApp X @ PP Aisyiyah

& C @ Ktaasunhouseco.id/pub

GiApps @ WA P Fgma @ Canva @ EJoumal & Gitlab (@ Instagram [] This huge black dia...

= PP Aisyiyah superadmin  }
Dashboard
Pengelolg Detail Pengguna
A Anggota - [
Database Cari Pengguna .{ Tambah Pengguna
>  DataWilayah superadmin@aisyiyah.or.id
Email Tgl Registrasi Status #
>  DataDaerah — | =
superadmin@a A - 14 Dec 2021 Aktif H
>  Data Cabang | |8
eksternal@aisy ... . 21 Jan 2022 Aktif H
D ey acehtimur@aig E 20 Jan 2022 Ak g
Pengaturan aceh_wilayah@ _ L 20 Jan 2022 Aktif H
© Pengguna fareedsurya@q 5 24 Jan 2022 Aktif H
iv@aisyi Batal i .
g KTA diy@aisyiyah.o m | 07 Feb 2022 Aktif H
Nems per page: 10 v 1-60f6 1K < > >l

Aisyiyah App Version 1.0.0

34. Bagaimana Cara Mengubah Data Pengguna
Pengguna> Klik Icon “ i ” > Klik “Detail” > Ubah data yang diinginkan > Klik “Simpan”
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@ PP Ay X @ rubah atau ubah -

< [¢] ktaa.sunhouse.co.id

Apps (@ wa Figma @ Canva @ EJoumal Gittlab (@ Instagram [] This huge

= PP Aisyiyah superadmin

B3 Dashboard
Pengelolaan Pengguna

& Anggota

Database Cari Pengguna ...

Nonaktifkan
> Data Wilayah

Emall Nama Role Tal Registrasi
> Data Daerah
superadmin@aisyiyah.or.id superadmin superadmin 14 Dec 2021 Ak Tentukan Wilayah
>  Data Cabang
eksternal @aisyiyah.or.id eksternal eksternal 21 Jan 2022 Ak Ubah Password
dmin_d h
>  DataRanting acehtimur@aisyiyah.or.id Admin Daerah (aKr::tASESTIMUR) 20 Jan 2022 Ak Hapus Pengguna
dmin_wilayah
Pengaturan aceh_wilayah@aisyiyah.or.id Admin Wilayah Aceh :‘A';'E":’)‘" v 20 Jan 2022 Aktif 3
admin_wilayah
@ Pengguna fareedsurya@gmail.com Farid Test (0 :(av(\;’:(A{(ARTA) 24 Jan 2022 Aktif H
o N admin_wilayah N .
& KTA diy@aisyiyah.or.id Admin DIY (D YOGYAKARTA ) 07 Feb 2022 Aktif H
tems perpage: 10 ¥ 1-60f6 K < > >l

Aisyiyah App Version 1.0.0

@ EJournal Gitlab (@ Instagram [] This huge

Detail Pengguna

Nama *
[ superadmir|

Email *

superadmin@aisyiyah.or.id

Hak Akses Pengguna

35. Bagaimana Cara Mengubah Password

Pengguna> Klik Icon “ i ” > Klik “Ubah Password” > Tuliskan password baru > Klik “Simpan”
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ktaa.sunhouse.co.id,

Figma @ C

Pembaruan Password

Password Baru

Tulis Ulang Password Baru

Batal

36. Bagaimana Cara Menonaktifkan/Mengaktifkan Pengguna
Pengguna> Klik Icon “ i ” > Klik “Nonaktifkan” atau klil “Aktifkan”

@ rubah atau ubah - Ge
ktaa.sunhouse.co.id

® wa Figma @ Canva @ EJournal Gitlab (@ Instagram [ This huge black dia..

= PP Aisyiyah superadmin  }

B3 Dashboard
Pengelolaan Pengguna

2 Anggota

Database Cari Pengguna

>  Data Wilayah
Email Nama Role Tal Registrasi st Detail

>  Data Daerah

superadmin@aisyiyah.or.id superadmin superadmin 14 Dec 2021 Ak Tentukan Wilayah
> DataCabang

eksternal @aisyiyah.or.id eksternal eksternal 21 Jan 2022 Ak Ubah Password
> DataRanting acehtimur@aisyiyah.or.id Admin Daerah ?i‘:;‘fé:?hTIMUR) 20 Jan 2022 Ak Hapus Pengguna
Pengaturan aceh_wilayah@aisyiyah.or.id Admin Wilayah Aceh ?irE'E"g")""a’ah 20 Jan 2022 Atif H
. N admin_wilayah N .
e Pengguna fareedsurya@gmail.com Farid Test (DI YOGYAKARTA ) 24 Jan 2022 Aktif H
I, N admin_wilayah B .
& KTA diy@aisyiyah.or.id Admin DIY (D YOGYAKARTA ) 07 Feb 2022 Aktif H

Items per page: 10 - 1-60f6 1€ 4 > >l

Aisyiyah App Version 1.0.0
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37. Bagaimana Cara Menghapus Pengguna

eyl
:

Pengguna> Klik lcon > Klik “Hapus Pengguna”> Masukkan kode> Klik “Hapus”

@ PP Aisyiyah X @ ruboh atau ubah - Google Ngge' X | +

< C @ kaasunhousecoid/public/pengguna

Gi Apps (B WA B Fgma @ Canva @ Eloumal &p Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin  §

B3 Dashboard
ull
Pengelolaan Pengguna

2 Anggota

Database

Cari Pengguna
Nonaktifkan
>  Data Wilayah
Email Nam: ole gl Registrasi st Detail
> Data Daerah
superadmin@aisyiyah.or.id superadmin superadmin 14 Dec 2021 Ak Tentukan Wilayah
> Data Cabang
eksternal @aisyiyah.or.id eksternal eksternal 21 Jan 2022 Ubah Pa
ata Ra dmin_daerah
> DataRanting acehtimur@aisyiyah.or.id Admin Daerah ?K’IT:IB"}\C‘EI[T"HMUR) 20 Jan 2022
dmin_wilayah
Pengaturan aceh_wilayah@aisyiyah.or.id Admin Wilayah Aceh acmin-wiiayan 20 Jan 2022 Aktif :
(ACEH) :
P E fareedsurya@gmail.com Farid Test admin. wilayah 24 Jan 2022 Aktif H
© Pengguna yaomarle = (DI YOGYAKARTA ) aneses o :
diy@aisyiyah or id Admin DIY admin.vilayah 07 Feb 2022 AKtif H
B KA vy (D.I YOGYAKARTA ) - - o :
10 -

Aisyiyah App Version 1.0.0

@ PP Aisyiyah X @ rubsh atau ubah - Google Nggo X |+

< C @ Kktaasunhouse.co.id/public/p

i Apps (B WA P Figma @ Canva @ Elournal & Gitlab (@ Instagram [ This huge black dia...

= PP Aisyiyah superadmin  }

BS  Dashboard
Pengelolaan Pengguna

2 Anggota
Cari Pengguna —
Erst superadmin@aisyyel  [<ONfirmasi Hapus Data Tambah Pengguna
> DataWilayah | Masukkan kode dibawah ini untuk konfirmasi hapus data
Email 0dTUF Tgl Registrasi Status #
> DataDaerah = | | =
superadmin@aisyiy 14 Dec 2021 Aktif H
> DataCabang E | | B
eksternal @aisyiyal 21 Jan 2022 Aktif H
>  DataRanting 5 L 7 b " .
acehtimur@aisyiya IMUR) 20 Jan 2022 Aktif H
Pengaturan aceh_ wilaysh@alg] Batal | 20 Jan 2022 Aktif H
. ho
Pengguna T ey i .
(2] g fareedsurya@gmail (D1 YOGYAKARTA) 24 Jan 2022 Aktif H
" L . " admin_wilayah _ .
& KTA diy@aisyiyah.or.id Admin DIY (DI YOGYAKARTA ) 07 Feb 2022 Aktif H
emsperpage: 10 v 1-60f6 1< < > >l

Aisyiyah App Version 1.0.0

38. Bagaimana Cara Mengubah Nama Ketua Umum dan Sekretaris Umum pada Kartu Anggota
KTA> Ubah nama pada kotak nama Ketua Umum dan Sekretaris Umum > Klik “Simpan
Perubahan”
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® (13) WhatsApp X @ PP Aisyiyah

< C @ Kkaasunhousacoid

Hidpps @ WA P Fgma © Cawva @ Eloumal & Gitlab (@ Instagram

[0 This huge black dia...

= PP Aisyiyah superadmin  }

B3 Dashboard

Pengaturan Kartu Anggota

& Anggota
Database

Ketua Umum

> Data Wilayah Nar

L Tanda Tangan
Dr. Hj. Siti Noordjannah Djohantini, MM, M_Si NBM/NBA. 548580/00013 \
> Data Daerah
> Data Cabang Ganti ttd
>  DataRanting Sekretaris Umum
fler o ! Tanda Tangan
Pengaturan Dra. Hj. Dyah Siti Nur‘aini, M.R1 NBM/NBA. 549014/00007 —_—
>
O Pengguna
B KA

Ganti ttd

Aisyiyah App Version 1.0.0 Stempel

39. Bagaimana Cara Mengubah Tanda Tangan pada Kartu Anggota
KTA> Tanda Tangan> Klik “Ganti ttd”> Pilih File > Klik “Gunakan Foto” > Klik “Simpan Perubahan”

@ (13) WhatsApp X @ PP Aisyiyah

< C @ kiaasunhousecoid

fpps B wAa P Figma @ Canva @ EJoumal &) Gitlab (@ Instagram

[ This huge black dia...

= PP Aisyiyah superadmin  §

B3 Dashboard

Pengaturan Kartu Anggota

2 Anggota
Database
Ketua Umum
> Data Wilayah Nar Nomor Anggota Tanda Tangan
Dr. Hj. Siti Noordjannah Djohantini, MM, M.Si NBM/NBA. 548580/00013 \

>  DataDaerah

>  Data Cabang

>  DataRanting Sekretaris Umum

Nar Nemor Anggota Tanda Tangan
Pengaturan Dra. Hj. Dyah Siti Nur'aini, M.P.1 NBM/NBA. 549014/00007

e Pengguna

B KA

Ganti ttd

Aisyiyah App Version 1.0.0

Stempel
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S
use.co.id,

Figma @ Canva @ Eloumal Gitlab (@ Instagram  [] This hug

Lampirkan Foto

Pilih File

Batal Gunakan Foto

40. Bagaimana Cara Mengubah Cap pada Kartu Anggota
KTA> Stempel> Klik “Ganti Stempel”> Pilih File > Klik “Gunakan Foto”> Klik “Simpan Perubahan”

® o d x P

& c ktaa.sunhouse.co.id

Apps (B wa Figma @ wa @ Elournal Gittab (@ Instagram [] This huge blac

= PP Aisyiyah superadmin  §

[Seane——pe
B3 Dashboard \

Ganti ttd
& Anggota
Sekretaris Umum
Database
Nama Nemer Anggota Tanda Tangan
i Dra. Hj. Dyah Siti Nur‘aini, M.P1 NBM/NBA. 549014/00007
>  Data Wilayah
> DataDaerah
Ganti ttd

>  Data Cabang

>  Data Ranting

Pengaturan

© Pengguna

& KTA || Ganti stampel
Simpan Perubahan

Aisyiyah App Version 1.0.0
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[¢] ktaa.sunhouse.co.id

Figma

Lampirkan Foto

Pilih File

Gunakan Foto

41. Keluar

Klik Icon “ { ” pada pojok kanan atas halaman > Klik “Keluar” > Klik “OK” pada kotak dialog
@ r

ktaa.sunhouse.co.id

Apps (B WA Figma @ Canva @ EJoumnal Gitlab (@ [0 This huge

= PP Aisyiyah superadmin  }

B3 Dashboard

[ Keluar
Statistik Pimpinan 'Aisyiyah
| 34 455 0 0 0
Database
Pimpinan Wilayah Pimpinan Daerah Pimpinan Cabang Pimpinan Ranting Pimpinan Cabang Istimewa
>  Data Wilayah
>  DataDaerah Jumlah Anggota ‘Aisyiyah
>  DataCabang 8 8 48 3 O
!
5 Data Ranting Anggota Terverifikasi Pengajuan Belum Validasi
Pengaturan
Anggota 'Aisyiyah Berdasarkan Wilayah
© Pengguna
NO WILAYAH JUMLAH ANGGOTA
B «a
1 JAWA TENGAH 35,081
Aisyiyah App Version 1.0.0
- . —
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